An Overview of TerminalFour Version 8
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Introduction

Testing TerminalFour Version 8

This document describes the changes and capabilities of TerminalFour version 8. The UMB upgrade from version 7 is expected to occur the week
of July 9, 2018. If you'd like to test version 8 before using it on live content, you can use the “Version 8 Testing” folder at:

SOD > University of Maryland School of Dentistry > SOD Moderator Training > Version 8 Testing

Feel free to create a new section within this folder for your own training needs.

Getting Help
For help and additional information, consult UMB’s resources:

https://www.umaryland.edu/cpa/toolbox/website-manual/

You can also reach out to Preston Stone, SOD’s Manager of Web Development, at pstone@umaryland.edu or by phone at 6-2673.



https://www.umaryland.edu/cpa/toolbox/website-manual/
mailto:pstone@umaryland.edu

Logging In
Site Structure and Actions

Version 8 of T4 has the same features and capabilities as version 7, but the interface has been redesigned to make some things easier to find and
use.
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When you first login, the Site Structure view is very similar to version 7, but with different colors and icons. Most important are the Content List
and Actions Button:

----------- [0 Sub Site Config
------------- BB Submit a Dental Digest Announcement

............. [ Blackboard

Content List Actions Button

The folder icons are slightly different:
-3 # University of Maryland School of Dentistry
-------- & &= Departments and Divisions

-------- B = Advanced Education in General Dentistry

....... B & Faculty < Dark folder: content visible on website

S [ Operative team <= Light folder: content hidden on website
------------- B Sedation Dentistry
------------- ' Academy of General Dentistry

------------ B About the Program

The dark folders indicate sections that are publicly visible on the website, and the white folders indicate sections that aren’t publicly visible.



The blue “Actions” button on the far right of each row replaces the yellow arrow in version 7. If you click the Actions button, you'll see this
menu:

DO [IZu

i + Create section
I [# Edit section

@& Praview section

Move section

8 Duplicate branch

Mirror branch

T Delete section

=+ Create content

[ Edit content

Wl Delete content

&3 Publish section
&3 Publish branch

# Direct edit
A Bookmark section

LEI Collapse all

The font is a little larger, and menu items are generally easier to read.



Sidebar Menu

Also notable is the left-side menu, which replaces the overhead menu in version 7. Here’s the old version:

Rights & Roles

And here’s how it looks in version 8 (note that your menu may look different if you’re not an administrator):

@ Content W
dan Sites & Channels b
P Assets W
@ Measure W
w Engage “w

i}ﬁ System administration e



This menu is a sidebar on the left side of the screen. The menu items open accordion style:

@ Content “
Create content
Edit content
Delete content
Approve contant
Media library
Recycle content
Content migration v

Integration tools W

If the menu takes up too much screen space, you can close it by clicking the arrow icon at the bottom of the sidebar:

©



Editing Content

To edit a section, click on its name. The layout of the section screen is very familiar:

%= General | B Content | & Contenttypes #-Page layouts | More~

General section details

Name * Neural and Pain Sciences A
Status Approved

Section options ~| Show in navigation
Archive section

eForm section

Advanced settings

Description Edit ~ Insert~ View~ Format~ Table~ Tools ~
= =E = == = = = ~ 32| | fec |
P LA AR S A S qeie e W A A A B
p Words: 0
SEO Title

Content owner & Select content owner

Output URI /meuralpain



Helpful tool tips are located throughout this screen. To learn more about a field or a button, hover your mouse pointer over it:

Name * Neural and Pain Sciences A

Sets the name of the section
Status Approved =

Note: these tool tips appear in many places in T4. When in doubt, point your mouse at a field or button to see if there’s more information.

To add and edit sections, click on the “Content” tab to get to this screen:

€21 Duplicate branch & Publish section

= General | [BContent | &> Contenttypes | #-Pagelayouts | More~

Content in this section

Enable automatic ordering CD

Display 10 + records Filter:
Order Name Version Status Last modified Publish date a
4 | Neural and Pain Sciences Header 20 January 29, 2018 9:21 AM NIA & Actions ~ IR
& General Header
4 | Department Slideshow 10 July 19, 2014 11:44 AM NIA @ Actions ~ [
&% Slideshow
4 | NPS homepage image 40 Fabruary 14, 2017 3:28 PM NIA
& Shde
4 | NPS Department Home Page Content 9.0 June 11,2018 2:19 PM N/A
& Quick Links
< | CODE: Column 1 10 @ October 3, 2015 10:31 AM N/A

& UME Code only

Showing 1 to 5 of 5 entries.
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Again, the layout is familiar. Icons and colors have been improved, to make it easier to see which content is approved or inactive. Note the cross-

shaped icon to the left of each piece of content — this allows you to easily reorder them. You can also click directly on the name of a piece of
content to edit it, instead of using the Actions menu.

Content Types

To create new content, click the green “Create Content” button in the upper right and choose a content type:

Choose content type
Display | 10 v | records

Content type

Announcement
An attention-grabbing announcement.

By The Numbers
Used to add content to the By The Numbers part of the home page

Calendar Event eForm

Calendar Event SOD
A School of Dentistry event for the common calendar

Calendar Event Uni Admin

A University Administration event for the commen calendar

Calendar Event Uni Admin Submission Form

Used to submit University Administration events to the Commn Calendar

Common Calendar Feed (Import URL)
Add an event feed from the common calendar to your page

Contact Box

This is a standardized display of Contact Information for offices and depariments

Countdown Timer With Text
Count down fo a specific date/time.

Countdown Timer Without Text
Count down fo a specific date/time.

Showing 1 to 10 of 57 entries

Content description

An attention-grabbing announcement.

Used to add content to the By The Numbers part of the home page

A School of Dentistry event for the common calendar

A University Administration event for the common calendar

Used to submit University Administration events to the Commn Calendar

Add an event feed from the common calendar to your page.

This is a standardized display of Contact Information for offices and departments.

Count down to a specific date/time

Count down to a specific dateftime.

Filter:

Group

Global

Global

Global

Global

Global

Global

Global

Global

Global

Global

L

4]

6



The list of content types is paginated, to make it a little easier to sort through them.

search for content types:

Choose content type

Display | 10 v records

Content type *

General Content
Can include paragraphs. images, efc.

General Header
A standalone title

Mega Menu General Content
Can include paragraphs. images, elc.

Six Column Content
Similar to General Content, but divided into six columns.

Showing 1 to 4 of 4 entries (filtered from 57 total entries)

Content description #

Can include paragraphs, images, stc.

A standalone title.

Can include paragraphs, images, etc.

Similar to General Content, but divided into six columns

11

In the upper right is a handy Filter tool, that allows you to

Filter: | general

Group %

Global

Global

Global

Global



Content Editor

The layout for the content editing screen is very close to the layout in version 7:

& Content Channels

7]

Content type : Quick Links

Name *

General Content Title

IMain Body *

History

NPS Depariment Home Page Content A

Edit + Inset~ View~ Format~ Table~ Tools ~

4 /B 7 U

1—
=
i=

The Department of Neural and Pain Sciences (NPS) is a Department of the University of Maryland School of Dentistry with research, teaching, and service responsibilities. Its
research and educational domains are in the area of neuroscience, with a strong emphasis on the neurcbiology of pain. NP5 faculty members conduct multidisciplinary sensory-
motor system research with @ major focus on acute and chronic pain mechanisms. Leaders in this depariment use state-of-the-art methods including advanced molecular,
neurophysiolegical, neuroanatomical, and neurcimaging technigues. As part of the school of dentistry, this department has a special interest in pain and dysfunction that

manifests itself in the orofacial complex. However, we also recognize that study of somatic and visceral pain models throughout the body will provide scientific advances that can
benefit our understanding of orofacial pain conditions.

A majority of the faculty conduct preclinical research. At the same time, the department also recognizes the need to transfer its groundbreaking basic science research into the
clinical setting, in order to better manage clinical conditions, especially chronic pain, and improve quality of life. As such, collaborative research with clinicians in the school of
dentistry, school of medicine, and elsewhere is an important part of our departmental mission. The science conducted by this department is integrated into the graduate and

post-graduate programs of the school of dentistry and the Graduate Program in Life Sciences (GPILS) through faculty driven curricular innovations and dedicated teaching
efforts.

Visit the Center to Advance Chronic Pain Research

p wWords: 242

The biggest difference here is in the layout of the text editor. Once again, helpful tool tips may be found here:

Edit = Insert - View -

6« 7|B 7 U

The UniversifiielB=ry|znd School ¢
anesthesia to make their dental apg

12



The new editor has a simplified toolbar:

Edit~ Inset-~ View~ Fomat- Table~ Tools -

4 # B I U
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Here’s the old toolbar for comparison:
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The new editor is designed to keep common tasks as toolbar buttons, while putting everything else in dropdown menus. Much of what you find
in the dropdown menus already exists as a button in the toolbar, for instance in the “Edit” menu:

Edit ~ Insert~ View~ Fom

4 Undo 3

 Redo e
pe

3 Cut

Ch Copy -

I Paste -

Paste as text
at

1=

Select all D
=t

gh
Find and replace e



The Format menu, which exists as its own dropdown menu in version 7, has been consolidated with other formatting options in version 8:

Format = Table - Tools =

e

-
il
.
il

P

I Italic ce of Institutional Advancement staff would be
e options include:

B Bold = R4

U Underline
55 strikethrough
» Superscript

X, Subscript
rsity of Maryland Baltimore Foundation,

+ adrministersad b the Dinivergite nf Mardand

Heading 1

Inling b Headi 2
T, Clear formattin eading
= d Blocks 3
Heading 3
Alignment b
Heading 4
Heading 5 M

Heading & L

It may also be useful to know that the “HTML” button has been replaced by the “Source Code” item in the Tools menu:

Tools =

spelicheck -

<> Source code

mmmmb A bhm T lmicmem i A E Bl -



The old editor had four different buttons for adding links. The new editor has one button, with a dropdown menu:

Fr 22 & T
iat  [=Insert section link 'g der
[ Insert content link
& Insert/edit external link

[l Insert anchor

Insert section link: inserts a link to another section in T4.

Insert content link: inserts a link to a piece of content within a section.
Insert/edit external link: inserts a web link to an external site.

Insert anchor: inserts a link to a location within the same page.

Most of the time, you’ll only need to worry about inserting a section link or an external link.
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Working with Images and Media

Media Library

Like other areas in T4, the Media Library has been redesigned for ease of use:

The media library is a centralised repository for media to be used within TERMINALFOUR. You can use it to create variants of your media such as cropped versions of images that

can be used in multiple pieces of content across many sites 1+ Bulk actions ~ + Add media
o

# Categorised S0D

™

& Media categories

o Display 10 v records Filter:
B B Categorised m Preview * Name % Version Status ¥ Filename % Type s Sizes =
- 253178 4 ~ |
T B Acadomic Alaks m Photo of Clint TangHow 6.0 Approved Clint Ta_ How JPG  Image ig 1
W AIDE 4 ~ |
@ M Arts m .{ , Barbara Andersson 30 andersso_.rab jpg Image | 532 £ Actions =
I Athletics, Recreation & Wellness m = ¥
B8 Communications m
B Design & Construction m Brandon Abel 9.0 abel_brandon_jpg Image igﬁ 4% Actions ~
- I Development & Alumni Affairs m
iubashien: m Bradly Linder 20 Approved brad.jpg Image 296 £ Actions -
- I Engineering m kB
8 Environmental Health & Safety m
I Finance, Budget, Accounting, and Internal Audit m - Eugene Khazanov 1.0 ekipg Image i;T
B General Business m il
B8 Graduate School m Sarita Sanjoy 30 Approved Sanjoy.jpg Image 306 ¥ Actions ~
- M Healthcare m ﬂ kB
_— [ |

The left sidebar is the list of categories, just like in the old version. Note that just above the category list is a “breadcrumb” navigation that
makes it clear where you are in the Media Library (in this case, “Categorized > SOD”). Media are displayed as thumbnail previews, with media
name and description, version number, current status, and other useful information.



Adding images and media is slightly easier in version 8. The media library is easier to navigate:

Display 10 v records

Preview “

Name %

anseloni_vanessa
Dr. Vanessa Anseloni

bai_guang
Dr. Guang Bai

benavent vanessa
Dr. Vanessa Benavent

brain
brain

brain_bee
Mational Brain Bee

chung_man-kyo
Dr. Man-kyo Chung

dessem_dean
Dr. Dean Dessem

Version &

1.0

20

1.0

1.0

70

1.0

q ¢
;.

i @

i

il |

i

Filter:
Filename = Type =
anseloni...ssa.jpg Image
bai_guang 3.jpg Image
benavent.. ssa jpg Image
brain.jpg Image
brain_bze jpg Image
chung_ma. kyojpg Image
dessem_dean jpg Image

Size *

122
kB

6.7 kB

554
kB

2098
kB

1738
kB

14.4
kB

17.8
kB

18

£ Actions ~

£ Actions ~

I 0

j

o

& Actions =
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£ Actions =



Much like the Content Type list, the media library has a “Filter” tool that allows you to search more easily for content within a folder:

Display 10 v | records Filter: | brain| ‘
Preview = Name = Version ¥ Status ¥ Filename = Type s Size 5
brain ) 20 brain.jpg Image 2098
brain kB
brain_bee brain_bee jpg Image 1738 £ Actions
Mational Brain Bee kB

i 8

greenspan_joel_brain greenspan_brain2jpg  Image  67.0

Dr. Jog! Greenspan kB

Showing 1 to 3 of 3 entries (fillered from 79 total entries) "

i -
>

19
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Adding Media
To add a new image, click the “Add Media” button in the upper right of the screen. The resulting screen should seem familiar:

4+ Add media

= General

Media details

Media file (Max: 15728640KB) *

-+ B

Media type Image
Name *
Description

Syntax highlighting language HTMLXML -
Media language dependence @) Fully independent

Independent media file

Fully dependent

Metadata

keywords

B Save changes

The Add Media screen has been redesigned to add a few minor features. Note that you can now drag a file to the screen in order to upload it.
The screen is a little more intelligent when it comes to determining file type.
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Media file (Max: 15728640KB) * Chronic-Pain-Brain-Image-C jpg (0.1 MB)

Media type Image -
Name * Chronic Pain Brain Image
Description Artwork depicting neurons

For images, enter descriplive text
unless the image is used for

Syntax highlighting language HTMLXML
layout or non-informative

i ] purposes, does not present
Media language dependence @) Fully independent g, P ——

Independent media filg el

Fully dependent

Once you’ve added an image, complete the process by adding a name and description. There is a helpful tool tip here to assist you in coming up
with description text.

Note: text from the Description field is used by visitors using screen readers to access content. For accessibility reasons, we require a description
unless the image is decorative.
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Creating Image Variants (Cropping and Resizing)

To create different size variations for an uploaded image, click the Actions button and choose “Variants”:

3 Chronic Pain Brain 2.0 Chronic-Pain-Brain- Image 1242
o mage Image-C.jpg L
s Artwork depicting neurons [ Edit

Move

Showing 1 to 4 of 4 entries (filtered from 80 total entries) 4

& Download

@ Delete

The Variants screen allows you to make cropped versions of an image, as well as resized versions. It has all the same functionality as the older
version of T4:

Use the tools below to create and edit variants of this media
Predefined variants Custom

v| Maintain aspect ratio W H




In the upper left of the Media Variants screen are two buttons that provide access to the variants tools:

Media variants Media variants
m tools below to cre Use melow to cre:s
g | .7 7| .~
Crop Resize

Once you’ve created an image variant, enter a name and description for it just below the image, then click “Create Variant”:

MName ®

Description

Finally, click “Save changes” in the lower right:

) Cancel Save changes

23



To insert an image from the Media Library into content, simply click on its name:

Brain Pain Banner

The selected media will then appear in content:

IMain Body *

Edit - Insert = View - Format - Table - Tools -

o) B 7 Y =

(il
bl
[}
ii
i
il
il
%
)
£
3
Oy

The Department of Neural and Pain Sciences (NPS) is @ Department of the University of Maryland School of Dentistry with research, teaching, and service responsibilities. Its
research and educational domains are in the area of neuroscience, with a strong emphasis on the neurcbiology of pain. NP5 faculty members conduct multidisciplinary
sensory-motor system research with a major focus on acute and chronic pain mechanisms. Leaders in this department use state-of-the-art methods including advanced
molecular, neurophysiological, neurcanatomical, and neuroimaging techniques. As part of the school of dentistry, this department has a special interest in pain and
dysfunction that manifests itself in the orofacial complex. However, we also recognize that study of somatic and visceral pain models throughout the body will provide
scientific advances that can benefit our understanding of orofacial pain conditions.

A majority of the faculty conduct preclinical research. At the same time, the department also recognizes the need to transfer its groundbreaking basic science research into
the clinical setting, in order to better manage clinical conditions, especially chronic pain, and improve quality of life. As such, collaborative research with clinicians in the
school of dentistry, school of medicine, and elsewhere is an important part of our departmental mission. The science conducted by this department is integrated into the
graduate and post-graduate programs of the school of dentistry and the Graduate Program in Life Sciences (GPILS) through faculty driven curricular innovations and

Lt

RN AR W T J

p Words: 242
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Saving and Publishing

Once you’re done editing content, you can preview, save, and/or publish it. The Preview and Publish buttons are in the upper right:

The Save Changes button is in the lower right. By default, clicking this button saves and approves the content (which means it will be published
the next time the site is refreshed). To save your work as a draft, click the arrow next to the Save Changes button and choose “Save as draft”:

Words: ?___|

|
+ Save and approve

Save as draft

| —
=y Cancel B Save changes I

Once you’ve published or saved the content, you’ll see a confirmation message at the bottom of the screen. I've saved this piece of content as a
draft, and the associated icon has changed on the content list screen:




-+ Meural and Pain Sciences Header
&% General Header

+ Department Slideshow
o Slideshow

+ NPS homepage image
& Slide

+ NPS Department Home Page Content
% Quick Links

-+ CODE: Column 1
& UMB Code only

Important Differences:

- Preview now appears in a frame on the same screen (instead of opening in a new window or tab).
- When you publish content, it is now placed into a publishing queue with all other publishing requests at UMB. This shouldn’t result in

2.0

1.0

4.0

9.01

1.0

any significant delays, but it does function a little differently.

January 29, 2018 9:21 AM

July 19, 2014 11:44 AM

February 14, 2017 3.28 PM

June 13, 2018 11:15 AM

October 3, 2015 10:31 AM
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